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TATA TERTIB PRAKTIKUM DAN PENGGUNAAN
LABORATORIUM
FAKULTAS TEKNIK

Tala Tertib Prakiikum dan Penggunaan Laboratorium bagi mahasiswa Fakultas Teknik sbb. :

3:

10.

1.

Mahasiswa berhak mengikuti suatu praktikum bila nama mahasiswa yang bersangkulan
terdaftar sebagai peserta praktikum. Mahasiswa yang tidak lerdaftar sebagai peserta dilarang
untuk mengikuli praktikum tersebut.

Hadir tepat waktu. Dosen dan asisten praklikum berhak mengeluarkan mahasiswa yang
terlambat hadir.

Untuk praktikum tertentu yang diwajibkan unluk mengenakan jas praktikum, mahasiswa harus
memenuhi ketentuan tersebut selama praktikum. Dosen danfatau Asisten berhak tidak

memperkenankan mahasiswa yang lidak mengenakan jas praktikum untuk masuk ke ruang
laboratorium dan mengikuti praktikum.

Waijib memberitahu kepada dosen / asisten praktikum secara tertulis bila berhalangan hadir
karena sakit atau hal lain yang mendesak {contoh : ada keluarga yang meninggal/sakit keras).
Bila tidak ada pemberitahuan, dapat dianggap TIDAK HADIR.

Dilarang menandatangani daftar hadir atas nama orang lain. Apabila dosen/asisten dapat
membuktikan bahwa mahasiswa tidak hadir dan daftar hadir ditanda tangani mahasiswa lain,
maka sanksi akan diberkan kepada mahsiswa yang tidak hadir dan mahasiswa yang
manandatangani.

Tidak diperbolehkan merokok., membawa makanan/minuman/senjata tajam selama berada di
ruang laboratorium.

Wajib menjaga ketenanangan dan tidak membuat keributan selama prakiikum berlangsung.

Wajib menjaga kebersihan dan dilarang mencoret-coret perlengkapan yang ada di suang
laboratorium ( seperti meja gambar, dinding, peralatan lain-lain ).

Harus duduk sesuai dengan nomor mesinfalal yang ditentukan oleh asisten alau dosen
praktikum.

Mengikuti prosedur peminjaman alat sesuai dengan kebijakan yang ditetapkan masing-masing
laboratorium.

Dilarang keras membawa pulang atau mengambil { secara sengaja alau lidak) peralatan dan
perlengkapan yang ada di ruang praklikum. Apabila dapat dibuktikan bahwa seorang
mahasiwa mengambil peralatan/perengkapan laboratorium, maka dapat dikenakan sanksi
akademik dan harus mengembalikan peralatan/perlengkapan tersebut.
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13.

14.

15.

16.

7.

18.

Dilarang keras melakukan pengrusakan alat dan perlengkapan yang ada di laboratorium (baik
secara sengaja maupun tidak). Apabila dapat dibuklikan bahwa seorang mahasiswa
melakukan pengrusakan peralatan/perlengkapan laboratorium, maka mahasiswa Ybs. Wajib
mengganti peralatan yang rusak tersebut.

Mengikuti arahan dan instruksi dan dosen dan asisten peraktikum dan bersikap sopan selama
mengikuli praktikum.

Berpakaian rapi, sopan dan lidak diperkenankan memakai sandal.

Untuk kelas praktikum parallel, mahasiswa harus hadir sesuai dengan jadual pada kelas yang

ditentukan dan dilarang pindah jadual tanpa pemberitahuan dan izin dosen dan/atau aisten
praktikum.

Meletakkan tas dan barang-barang lain milik mahasiswa yang tidak dibutuhkan selama
praktikum pada rak atau lempat yang tetah ditentukan.

Apabila ada keperluan untuk menggunakan laboratorium untuk keperluan insidential diluar

jadual praktikum, harus melapor ke Jurusan/Kepala Laboratorium dan mengisi buku
permohonan penggunaan laboratorium,

Bagi mahasiswa yang melanggar tata tertib praklikum dan penggunaan laboratonum di alas
dapat dikenakan SANKSI AKDADEMIK.

Jakarta, Maret 2016
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PENILAIAN

Berikut adalah persentase pentlaian untuk praktikum pengendalian
kualitas:
¢ Reguler
1. Absensi: 10 %
2. Tugas : 20 %
3. Quiz: 15%
4. Laporan: 25 %
5. Presentasi : 30%
¢ Eksekutif
1. Absensi: 10 %
2. Tugas:25%
3. Laporan: 45 %
4. Quis:20%

Jakarta, Maret 2017
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BABI

FLOWCHART

Flowchart adalah Flowchart/diagram alir merupakan bagan,diagram dengan
simbol-simbol tertentu yang menggambarkan aliran proses dengan langkah-langkah
yang berurutan secara dan mendetail Flowchart memuat grafik dan tahapan proses

yang membedakan data berdasarkan sumbernya.

Elemen yang dicakup dalam flowchart adalah wrutan tindakan, input dan
output proses, keputusan yang harus dibuat, orang yang terlibat, waktu di tiap
tahapan, dan lainnya.Flowchart dibuat dan digunakan untuk untuk memahami
bagaimana suatu proses dilakukan, mempelajari proses untuk perbaikan, untuk

komunikasi, untuk mendokumentasikan proses, untuk merencanakan proyek.

Simboi-simbol pada flowchart yang menggambarkan proses tertentu
membantu kita dalam memahami suatu aliran proses yang kompleks, seperti proses

bisnis, algoritma pemrograman, atau alur kerja padastandard operational
procedur (SOP).

Sebelum menggambar Flowchart terlebih dahulu kita harus mengetahui
simbol-simbol flowchart itu sendiri. Nah ini adalah gambar beberapa simbol

flowchart yang biasa digunakan.



SIMBOL -SIMBOL DIAGRAM ALIR
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Dalam microsoft visio ada beberapa simbol flowchart dibuat dengan

menggunakan basic objek . Adapun caranya adalah seperti berikut :

1. Buka File > New > Flowchart > Basic Flowchart {Metric)

[0 NewDriwing (Meric)  CibeN

L) Mew Drawing fLS Units)
G New Drawing from Jemplale...

G Butines ’ -
»
Pulish a5 BDF or XPS._. Ch Powcur » @y Baric Flamechart (Vetri)
Bemove Hidden Tnfoomation . |@ Geswra » B Busic Powchart (US unds)
@ s v |2 Mups and Foor Plares » |8d Crocy Funcrional Fiowchant (Metric)

2. Langkah selanjutnya adalah meletakkan simbol-simbol flowchart ke datam kolom
yang telah dibuat.Simbol-simbol flowchart yang ingin digunakan dapat di ambil
di Shape menu yang berada di panel sebelah kin.




Apabila ada simbol yang tidak ada di dalam panel shape menu kita bias

l;'i'm“"
menambahkan melalui standard toolbar dan klik icon @Setelah itu maka
dibuatlah flowchart sesuai proses yang dilakukan. Berikut adalah contoh flowchart.
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BAB II

CHECKSHEET

Checksheet atau Lembar Pengumpulan Data Lembar terstruktur yang dipersiapkan
unfuk pengumpulan dan analisis data. Lembar ini adalah alat umum yang bisa
digunakan untuk tujuan yang luas. Checksheet digunakan bila data bisa diamati dan
dikumpulkan secara berulang oleh orang yang sama atau pada lokasi yang sama,bila
dikumpulkan data frekuensi atau pola dari kegiatan, masalah, cacat, penyebab cacat,

dan lainnya.dan bila dilakukan pengumpulan data dari proses produksi.

Untuk membuat sebuah checksheet maka diambil data dari minitab untuk random

datanya.

1. Pada awalnya isi nama dari data variabel yang akan dirandom,misalnya panjang ,
lebar, dll. Klik Calc > Random Data >Normal (untuk data vanabel). Setelah itu isi
number of rows nya 50 untuk mendapatkan nilai 50 data dan pilih store in
column(s) dengan klik kotak yang tersedia di tengah hingga muncul pilihan isian
kolom disebelah kiri yang berisi data variabel dan pilih data variabel yang akan
dirandom Lalu isikan nilai mean dengan nilai spesifikasi dari produk dan nilai
standar deviasi 1.0

2. Pada awalnya isi nama dari data atribut yang akan dirandom,misalnya warna ,
tekstur, dll. Klik Calc > Random Data >Interger (untuk data atribut). Setelah itu
isi number of rows nya 50 untuk mendapatkan nilai 50 data dan pilih store in
column(s) dengan klik kotak yang tersedia di tengah hingga muncul pilihan isian
kolom disebelah kiri yang berisi data atribut dan pilih data atribut yang akan

dirandom. Pada nilai minimum isikan angka (0 dan maksimum isikan ).

Dari data yang telah dirandom maka dipindahkan ke kolom checksheet yang
berisi data variabel dan atribut dengan asumsi 10 subgrup dan 5 kali pengamatan di
Microsoft Excel. Lalu data tersebut dipindahkan, Buatlah batas kendali atas dan
bawah dari data variabel yang ada. Lalu blok atau tandai nilai-nilai data yang
melewati batas ketentuan atas atau bawah yang ditentukan. Hitung jumlah data
produk yang telah ditandai lalu di masukkan ke lembar checksheet dan dijumlahkan
untuk mengetahui total cacat yang ada.



BAB III
HISTOGRAM

Histogram adlah grafik yang digunakan untuk menunjukkan distribusi frekuensi,
atau seberapa sering tiap nilai muncul dari data yang ada.Suatu distribusi frekuensi
menunjukkan seberapa sering tiap nilai berbeda yang ada dalam set data
muncul Histogram adalah grafit  yang paling banyak digunakan untuk
memperlihatkan distribusi frekuensi.Bentuknya seperti grafik batang. Histogram
digunakan bila data bersifat terukur, bila kita ingin melihat bentuk dari distribusi data,
untuk menganalisis apakah proses dapat memenuhi permintaan konsumen, untuk
menganalisis output dari proses pemasok, untuk melihat adanya perubahan proses dari
waktu ke waktu,ntuk menentukan apakah ousput dan dua atau lebih proses berbeda,

bila kita ingin mengkomunikasikan distribusi data secara cepat dan mudah.

Sebelum mengambil kesimpulan, pastikan bahwa proses beroperasi secara normal

selama pengamatan. Analisis arti dari bentuk histogram yang muncul.

ANormal distribution

Pola yang umum terjadi seperti kurva-berbentuk lonceng yang dikenal dengan
distribusi normal. Titik-titik data akan muncul pada satu sisi dari nilai rata-rata sama

besar peluangnya dengan pada sisi satunya.



F .

Right-skewed distribution

Distribusi yang menceng (skewed) tidak simetris karena adanya batasan alamiah

yang mencegah terjadinya hasil pada satu sisi.

adk

Bimodal (double-peaked) distribution

Dua proses digabungkan dalam satu hasil pengamatan.

Plateau distribution

Beberapa proses dengan distribusi normal digabungkan.

il

Comb distribution

Kesalahan dalam pembuatan histogram.



Truncated or heart-cut distribution
Hasil dari inspeksi (hanya yang masuk dalam spesifikasi)
Cara membuat histogram dengan aplikasi minitab

1. Klik Calc Graph > Histogram
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2. Pilih Single with Fit Lalu isikan graph variables dengan data variabel yang ada

setelah itu klik data view dan klik fit distribution. Klik Ok

Terakhir klik Ok. Lalu muncul hasilnya.
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BAB 1V
‘ SCATTERPLOT

Diagram scatter digunakan untuk melihat hubungan diantara dua
variabel Bila terdapat korelasi, titik-titik yang terplot akan membentuk sebuah garis
atau kurva.Semakin baik korelasinya, maka makin rapat titik-titik tersebut mengikuti
garis atau kurva. Diagram Scatter digunakan bila varabel dependen memiliki

beberapa nilai untuk tiap nilai dari variabel independen.Untuk menentukan apakah

dua variabel saling terkait, misalkan untuk mengidentifikasi akar penyebab potensial
dari masalah.Untuk menentukan apakah dua dampak yang terkait muncul karena

sebab yang sama.
Cara membuat scatterplot dengan aplikasi minitab

1. Klik Calc Graph > Scatterplot
fll Minitab - Scatter.MPJ i BRI i, s

1 Eile Edit Data Calc Stat[ ﬁraph E_dntor Took Window ];lelp Assistant
(@ x| - L —

lﬁ'l"g'—%a rﬁlﬁ‘l*@! e Matrix Plot...

Marginal Plot...
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2. Lalu isikan data yang dianggap memiliki hubungan.
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BABY

DIAGRAM PARETO

Diagram Pareto berbentuk grafik batang untuk memperlihatkan faktor-faktor

yang paling signifikan.Panjang dan batang menunjukkan frekuensi atau biaya, dan

diatur dengan batang terpanjang di kiri dan yang terpendek di kanan.Dengan cara ini,

diagram akan memperlihatkan situasi yang paling signifikan. Diagram Pareto

digunakan untuk menganalisis data mengenai frekuensi dari masalah atau

penyebabnya dalam proses bilamana terdapat banyak masalah atau penyebab dan kita

ingin berfokus pada yang paling signifikan, untuk menganalisis penyebab yang besar

dengan melihat pada komponen-komponen spesifiknya dan untuk mengkomunikasikan

data.

Cara membuat diagram pareto dengan aplikasi minitab

Isi Kolom dengan Tinggi dan Frekuensi

Klik Calc Stat> Quality Tools > Pareto Chart

m Minitab - PARETO.MPJ

Dol . RESREORRREY LSRR

| Ete Edit Data Calc| stat graph Eg[ltor Tools yImdow Help Assistant
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J L l = z | ANOVA
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Control Charts
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Pareto Chart of TIh
Multivariate
122 meaeres
Tables
Nonparametrics
Welcome to Minitab,
Retrieving project EDA
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. Isi Defect or Attribute data in dengan diklik dan pilih data disebelah kiri pilih Tinggi
dan Frequencies in pilih frekuensi. Nilai Combine remaining defects into one

category after this percents isi dengan nilai 95

Welcome to Minitab, pres
Retrieving project from

(% Defauk (4l on one graph, same ordering of bars) ‘
{" Cne qroup par graph, same ardering of bars
(" One roup per graph, independnt ordering of bars

T
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4 (166170
5 1118
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{" Do not ambine

k ok, lalu muncul hasil nya

1122014 21:
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g Lo
]
3 S
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151185 5| - _ Lo
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BAB V1
FISHBONE
Diagram Sebab-Akibat mengidentifikasi berbagai penyebab yang mungkin dari
1 dampak atau masalah.Diagram ini dapat digunakan untuk strukturisasi dari sesi
troming. Karena secara cepat membagi ide kedalam kategori yang berguna.
ini juga dikenal dengan diagram tulang ikan atau diagram ishikawa. Diagram
akan untuk mengidentifikasi berbagai penyebab yang mungkin dan suatu

Khususnya bilamana pemikiran tim cenderung mengarah pada kesimpang-

Maiorl-als Molhods

R MReinis Anahﬁw oroeadue
\Supoﬁv\ City '\ Supglier 1
Tm:t 3\ Plnntqi\Suwauz % %',
Syaten o\
Lab tohnt mmmm

\¥=

Contoh Diagram Fishbone
{ diagram pareto dengan aplikasi miniteb

lom dengan Jenis Penyebab Masalah dan Sub nya.
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2. Klik Calc Stat> Quahty Tools > Cause and Effect
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5
B 4, Klik Sub... Lalu isi Causes sesuai dengan label. Klik Ok
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BAB VII

CONTROL CHART

Kendali atau Control Chart adalah grafik yang digunakan untuk mengkaji
a proses mengalami perubahan sepanjang waktu. Jenis peta kendali yang

n bergantung pada jenis dari datanya yaitu :

variabel diukur pada skala yang kontinu. Misalnya: waktu, berat, jarak atau
tur bisa diukur sampai skala desimal.
atribut dihitung. Muncul bilamana kita menentukan hanya kemunculan atau

k adanya sesuatu: sukses atau gagal, terima atau tidak, benar atau salah.

kendali adalah grafik yang digunakan untuk mengkaji perubahan proses
ke waktu.Data di-plot berdasarkan urutan waktunya. Peta kendali sclalu
ris pusat untuk nilai rata-rata, garis atas untuk batas kendali atas, dan garis
k batas kendali bawah.

1 Kendali digunakan untuk mengendalikan proses yang berlangsung
:ﬁ,eﬁemukan dan memperbaiki peermasalahan yang muncul, untuk
rentang yang diharapkan terhadap hasil dari proses. untuk menentukan
tu proses stabil (dalam kendali statistikal), :ntuk menganalisis pola vanasi
%_pe.nyebab khusus (kejadian tidak-rutin) atau penyebab umum (inheren
rhadap proses), untuk menentukan apakah proyek perbaikan kualitas harus

1cegah masalah spesifik atan membuat perubahan fundamental terhadap proses.

a kendali akan memberikan proses yang konsisten (atau stabil) dalam
iasi yang dianggap alamiah.Stabilitas ini hanya sebatas bahwa proses
am batas-batas kendali, dan tidak memperhatikan keterkaitannya dengan
spesifikasi!
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titik ke-21 adalah

| S,

3

diluar batas-batas kendali. Di Gambar, titik ke-16 diluar batas

1 delapan titik berada pada sisi yang sama dari garis pusat. Atau 10

12 dari 14 titik atau 16 dari 20 titik. Di Gambar

titik ke-4 memberikan sinyal ini.

Proses.

ri lima titik berurutan pada satu sisi yang sama dari garis pusat dan lebih
konsisten secara jelas yang mengindikasikan sesuatu yang tidak biasa

1o. Di Gambar, pada titik ke-11.

pa titik berurutan pada satu sisi dan garis pusat dan lebih dan batas 2o,

¢saan Control Chart

tunggs




Control Chart dengan aplikasi minitab

g

masx yang ada ukuran sample dan banyaknya produk cacat.
- Control Charts >Attributes Charts>P
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